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1. Introduction 

This document describes the EDGE CAD editor, the context and the concepts behind its con-

ception, as well as its use.   

Reference documents 

[RD1] GDML Web page, http://gdml.web.cern.ch/GDML/ 

[RD2] Geant4 Web page, https://geant4.web.cern.ch/geant4/ 

[RD3] SpaceSuite Web site, www.space-suite.com 

[RD4] Santin G. et al., “GRAS: A General-Purpose 3-D Modular Simulation Tool for Space Environment 

Effects Analysis”, IEEE Trans. Nucl. Sci., Vol. 52, No. 6, December 2005 

[RD5] Jeanty-Ruard B. et al, “Advanced CAD Tool and experimental integration of GRAS/Geant4 for 

internal charging analysis in SPIS”, Proceedings, 14th Spacecraft Charging Technology Conference, 

ESA/ESTEC, Noordwijk, NL, 04-08 APRIL 2016 

[RD6] Keridwen open-source IME Web site, www.keridwen.org 

[RD7] SPINE community Web site, www.spis.org 

[RD8] EDGE project Web page, http://www.space-suite.com/edge 

[RD9] GDML USER’S GUIDE; Version 2.7; http://gdml.web.cern.ch/GDML/doc/GDMLmanual.pdf 

 Acronyms and abbreviations 

• B-Rep: Boundary Representation 

• CAD: Computer Assisted Design 

• CSG: Constructive Solid Geometry 

• EDGE: ExtendeD Gdml Editor 

• GDML: Geometry Description Mark-up Language 

• GUI: Graphical User Interface 

• IME: Integrated Modelling Environment 

• STL: STereo-Lithography 

• UNV: Universal File Format 

• XML: Extensive Markup Language 

http://gdml.web.cern.ch/GDML/
https://geant4.web.cern.ch/geant4/
http://www.spis-services.eu/
http://www.keridwen.org/
http://www.spis.org/
http://www.space-suite.com/edge
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2. EDGE objectives 

EDGE — for ExtendeD Gdml Editor — is an easy-to-use GDML-based CAD editor. It provides 

a powerful and flexible CSG model fully compliant with the GDML CAD format [RD1], used by 

numerous particle-matter interactions analysis tools based on the Geant4 library [RD2]. EDGE 

provides also various import/export capabilities from/to B-Rep based CAD formats.  

EDGE has been developed by Artenum in the frame of its internal R&D activities and is avail-

able through several of its commercial services offers, like SpaceSuite [RD3].  

2.1. About GDML 

Based on XML syntax, the Geometry Description Markup Language (GDML) is the reference 

language used to describe geometrical models (i.e. CAD models) for radiation modelling tools 

like Geant4 [RD2], ESA/GRAS [RD4] or SPIS-IC [RD5]. GDML is based on a rich CSG ap-

proach and can be used to create complex and realistic geometrical systems to be used for 

various purposes. 

As an XML-based language, it can be fairly well read by humans and it is quite simple to parse 

it. However, one of its limits is that it is difficult to visualise what a GDML file is going to produce 

just by looking at it in a tailored sense, i.e. as a 3D geometrical system. Although some viewers 

or editors exist, only a few of them are publicly available, and they are not user-friendly or 

incomplete. Moreover, most GDML editors so far cannot handle the depth hierarchy used in 

GDML. 

Therefore, Artenum decided to develop a GDML editor based on the IME Keridwen [RD6]. Its 

aim is to propose a simple-to-use, cross-platform editor with good capacities of visualization.  

2.2. Caution and limit of warranties  

The present document is intended to be a simple User Manual (UM) to help the user to use 

EDGE in basic mode to create CAD modelling. This document does not attempt to provide to 

the future EDGE user the whole expertise and knowledge needed to create a correct CAD 

modelling. The final confidence in the relevance and accuracy of the CAD model depends on 

the user expertise and remains his responsibility.  

FOR THIS REASON, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING, 

THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS 

IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUD-

ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 

PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 

DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 

https://geant4.web.cern.ch/geant4/
http://space-env.esa.int/index.php/geant4-radiation-analysis-for-space.html
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CORRECTION. For an improved handling of the key concept addressed by EDGE, we strongly 

recommend to contact SpaceSuite. 

NB: for further information, please contact the SpaceSuite team on http://www.space-suite.com or at 

contact@space-suite.com. 

2.3. Main functionalities 

EDGE can either create or load a complete GDML model. In both cases, the user can modify 

the properties of all the shapes or add new shapes. Moreover, shapes also have position and 

orientation properties that allow placing them correctly. To facilitate the work for the user, po-

sition and orientation can be applied to several objects at the same time. EDGE handles com-

plex hierarchies with several levels of depth.  

EDGE also allows editing and attributing material properties to each shape individually. At any 

time, the user can see the results of his work thanks to the real-time 3D. 

After editing his file, the user can save the result back to GDML but he can also export it to the 

B-Rep .geo format (the file format of Gmsh)1.  

2.4. Supported formats 

2.4.1. Import 

EDGE support natively the GDML format in reading and writing, but is also able to import 

numerous B-Rep CAD formats like Gmsh’s geo or STEP-AP 203/214 and tessellated solids in 

STL or UNV files. These import/export capabilities open interoperability bridges with other CAD 

tools and multi-physics simulation software. 

  

Figure 1: Example of imported STEP-AP model inside EDGE 

 
1 http://geuz.org/gmsh/ 

http://www.space-suite.com/
mailto:contact@space-suite.com
http://geuz.org/gmsh/
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2.4.2. Export and CSG-to-B-Rep decomposition 

EDGE is able to convert GDML models into an equivalent Gmsh’s geo file, fully compliant with 

tailored applications like SPIS [RD7]. This conversion is not done by tessellation but by a 

proper CSG to B-Rep decomposition with the view in Gmsh (on the right of Figure 2) of a model 

initially defined in EDGE (on the right of Figure 2). 

   

Figure 2: CSG to B-Rep decomposition of a GDML model defined in EDGE (left)  

visualized in Gmsh (right) 
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3. Using EDGE 

3.1. Supported platforms  

Currently, EDGE can be used on most 64bits Linux platforms, Microsoft Windows-7-8-10 

32/64bits and OSX/MacOS 10.10.5 and higher 64bits.  

3.2. Starting Edge 

The application as well as the present User Manual can be downloaded from the SpaceSuite 

Web page [RD8].   

Once downloaded, the zip file containing the EDGE snapshot has to be extracted on the ma-

chine where it will be used on to ensure that the software is executable.  

NB: on Windows systems, the native unzipping method may encounter issues when unzipping EDGE. 

You may want to use third-party application to avoid issues. The unzip has been successfully tested 

with the 7Zip application. 

i. Linux  

Depending on your precise Linux distribution, double-clicking on the Edge.sh file may launch 

the application correctly (see below for more details on Gnome environments).   

To start the application, it is also possible to open a terminal and just execute ./Edge.sh in 

the application directory. It is then possible to indicate launching options, see the Command-

line launching options paragraph below. 

NB: on recent Linux distributions with Gnome, double-clicking on the Edge.sh displays the content of 

the file instead of launching it. You can modify this behaviour by going to the file manager preferences 

and changing the way executable files are handled. 

ii. MacOS 

To start the application, you need to open a terminal and execute the Edge.sh file. It is possible 

to indicate launching options, see the Command-line launching options paragraph below. 

iii. Windows 

Double-clinking on the Edge.bat will launch the application. To use more advanced launching 

options, you can open a command invite and type Edge.bat. Options can be provided, see 

the Command-line launching options paragraph below  

For compatibility with all Windows systems, it is not possible to launch several EDGE at the 

same time on Windows. If you want to be able to launch several instances, you need to edit 

the EDGE.bat file and test if this function works on your system. Once the file is opened in your 

favourite text editor look for the following part: 

http://www.space-suite.com/edge
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set NOW=1 

and replace it with the following content (on one line, without line-break): 

set NOW=%date:~-4,4%%date:~-7,2%%date:~-10,2%%FormatedTime:~-11,2%%For-

matedTime:~-8,2%%FormatedTime:~-5,2%%FormatedTime:~-2,2% 

Save the modification and relaunch EDGE. If EDGE starts, you will be able to launch several 

instances of your software. If not, please revert the modification to be able to use EDGE: your 

system does not support launching several instances by using the automatic date computation 

mechanism. 

iv. Command-line launching options 

It is possible to use options to launch EDGE. The options can be added (up to one at a time) 

after the launching command. To know all the available options, the option –h can be used 

(such as ./Edge.sh -h or Edge.bat -h).  

-f path/to/gdml/file.gdml 

This option enables loading the given file directly in the application at start-up. 

3.3. EDGE Main Window 

The GUI of EDGE is intuitive and based on the concept of “perspectives”, where the modelled 

system can be viewed and handled from different approach or points of view, like the edition 

of the geometrical model, the definition of material properties or the assignment of these ma-

terials to their correct geometric shape. 

As shows the Figure 3, some elements of the graphical interface are common for all perspec-

tives:  

•  Main Menu corresponds to main control menu of the application.  

•  General Toolbar presents shortcut buttons to open and save (on the left) a file and 

also allows switching from a perspective to another (on the right). This toolbar also 

grants access to the preferences panel.  

  …  
  

Figure 3: Main elements of EDGE window (here in the geometry perspective) 

1 

2 

 
 

1 
2 
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3.3.1. Main Menu 

i. File menu 

The File menu (shown on the right) allows opening and saving 

GDML files and also various import and export options. An option 

also permits opening recent files. Finally the exit option enables 

leaving the application. 

Please note that EDGE can only load one file at a time. When open-

ing a GDML file, if there are unsaved modifications, the application 

will propose to save this work before replacing it by the new opened 

file. 

In its trial version, EDGE does not allow exporting or saving to GDML. 

NB: EDGE tries to load all files, even if there are inconsistencies. For example, if a file contains two 

solids with the same name, EDGE will only consider the last element with this name and inform about 

this issue and the chosen resolution.  

ii. Tools menu 

The Tools menu (shown on the right) offers various tools and 

shortcuts. From here, you can access the preferences panel pre-

sented in section 4. The console log is displaying various mes-

sages from the application such as errors and warnings. 

With this menu, it is also possible to apply corrective patch to 

EDGE or install new feature plugin. To do so, click on the correct 

item and a file choose will appear and asks where the patch/plugin 

is located. Once installed, it is recommended to restart the appli-

cation.  

This menu also offers access to various tools and model computation operations which are 

described in more details in section 5.5. 

iii. Other menus 

The Views menu allows switching from one of the perspectives presented earlier to another. 

The Help menu is useful to access this user manual directly from within the application. This 

menu also offers the about screen, resuming information about the software and installed 

plugins/patches.  

3.3.2. General Toolbar 

The left part of this toolbar allows the user, thanks to three buttons, to access the Preferences, 

presented in section 4, and to easily open and save a file without opening the File menu pre-

sented in 3.3.1. 
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The right part of this toolbar presents four buttons allowing the user to switch between the four 

main perspectives of EDGE: the Geometry edition (visible on Figure 9, see section 5), the 

Material definition (see section 6), the Material affectation one (see section 7 for more infor-

mation) and finally the GDML File perspective (see section 8). 
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4. Preferences 

The Preferences dialog box allows the setting of the applications options. For each option, a 

“Reset to default” button allows switching back to the initial value. 

At the first launch of the application, the Preferences dialog box is shown and enables the user 

to change the default parameters right away. 

4.1. 3D viewer preferences 

 

Figure 4: 3D viewer preferences panel 

The first tab display options about the 3D viewer of the application as shown on Figure 4: 

• Default 3D view shape opacity: sets the default opacity used when adding a new 

shape to the 3D view. Indeed, a colour is automatically chosen for every new shape 

and this setting will choose the opacity for this colour. The value 0.0 is fully transparent 

while the value 1.0 is fully opaque. Please note that this setting will not change the 

opacity of the shapes already displayed in the 3D view; 

• Display sizes in the 3D view: this option activates an additional widget when selecting 

elements in the 3D view: the size (in meters) are directly shown. It is disabled by default 

for better clarity in the 3D view. 
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4.2. GDML default material preferences 

 

Figure 5: GDML default materials preferences 

The second tab — shown on Figure 5 — offers options concerning the default GDML materials 

used in the application. Indeed, when a new shape is created in EDGE, a default material is 

assigned to it that can be changed later on in the Material Assignment perspective (see section 

7 page 35).  Here, it is possible to select which material will be assigned to the world element 

and to other elements. The selection can be performed from within the EDGE default materials 

list and the Geant4 default materials list. 

4.3. GDML writer preferences 

  

Figure 6: GDML writer preferences 

The second tab, shown on Figure 6, sets parameters for the GDML writer: 

• Write default values: if this option is selected, the values for optional fields will be 

written even if they equal to the default value — it is the case for example for the posi-

tion and orientation (0 is the default value); 

• Write default units: if this option is selected, the units will always be specified inside 

the GDML file even if they equal to the GDML default units (mm for lengths and radians 

for angles); 
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• Write non-used user-defined materials: if this option is selected and that the user 

has defined materials which are not assigned to a geometric shape, those materials 

will be stored in the GDML file anyway; 

• Save chosen colours to GDML file: if this option is selected, the colours chosen in 

the Geometry panel will be saved to the GDML file using the <auxiliary> tag, and 

then when loading the file the colours will be the same. Be careful, the content of the 

<auxiliary> tag is not interpreted by the Geant4 numerical kernel. This tag is usually 

properly treated by the client code as explained in the GDML user manual [RD9] 

• Validation mechanism in GDML file: Choose the reference to the GDML file validator 

(.xsd) defined in the GDML file after the save action in EDGE. The choices are: 

o online (the validation process requires an internet connection when the file in 

other tools is loaded); 

o local (the validation is made locally with a validator file embedded on the local 

computer. The saved GDML file can only be used on this computer as long as 

the software is not moved); 

o none (no reference to a GDML file validator is written, then no validation will be 

processed when the GDML file will be used by other tools). 

4.4. General preferences 

  

Figure 7: General preferences 

The third tab offers more general usability preferences, as shown on Figure 7: 

• Distance unit for new shapes: this setting enables toMaximum number of recent 

files: this option controls the number of recent files stored by EDGE and accessible in 

the Open recent… menu.  

• Enable drag’n’drop: enables the possibility to move the elements in the Shapes tree 

using drag and drop gesture with the mouse. It facilitates the modification of the hier-

archy — to avoid unwanted modifications, this option is disabled by default;  
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• Display “Add new shape” labels: display shortcut labels in the shapes tree of the 

Geometry Edition perspective. These labels help to gain time to add new shape but 

this option is disabled by default to gain cleanliness. 

4.5. System preferences 

   

Figure 8: System options 

The last tab sets preferences for the system, as shown on Figure 8. The user can choose: 

• Application cache directory: by clicking on the “Browse” button, the user can choose 

the path where the application stores its temporary files. It may be useful to change this 

setting if you do not have write access to your temporary folder (by default EDGE uses 

the operating system default temporary folder); 

• Maximum allocated memory: the user can choose the value and unit (Mo or Go) of 

the available memory for EDGE. It can be useful to increase this value when loading 

very big files, without exceeding the system maximum capabilities. 
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5. Geometry Edition 

The Geometry perspective is the main perspective of EDGE since it allows the creation and 

the edition of geometrical elements. 

5.1. The Geometry edition perspective 

It is the main perspective of EDGE displayed by default at the launching. It has three main 

panels to edit the geometry, as shows Figure 9: 

•  Shapes Tree panel, to visualise and edit the list of geometric shapes; 

•  Properties panel, to edit the properties of the currently selected shape; 

•  3D Viewer panel, present only for the geometrical edition and material affectation 

perspectives, provides a 3D view of the modelled system.  

These panels, as well as the 3D View panel, can be moved, detached or maximized at the 

user’s liking using the buttons on their top right corner. 

  

Figure 9: EDGE geometry edition view 

  

1 

2 

3 

 

  1 

2 

3 



 EDGE 2.5.0 

User Manual 
PAGE 

18/49 

 

Status: final Date: 30/10/2020  

 

5.1.1. Shapes tree 

The Shapes tree lists all the shapes currently defined in the geometrical model and displayed 

in the 3D scene. It also shows the hierarchy of the shapes. The shape(s) currently selected is 

(are) highlighted in the 3D view on the right with a red box. It is also possible to move one 

geometry element and all its children elements to another logical location in the geometry tree. 

This feature is available only if the drag’n’drop option has been enabled in the Preferences, 

see section 4. 

On the right of each shape, a click on the coloured box opens a dialog that allows changing 

the colour of the shape in the 3D view. It is also possible to change the transparency of the 

selected element in this dialog box, as shown on Figure 10. A checkbox on the right controls 

the visibility of the object in the 3D view.  

 

Figure 10: Colour changing dialog box 

On top of the tree, six buttons are used to control the shapes:  

• The four buttons on the left side allow adding, duplicating, removing shapes and/or 

creating Boolean operations. The first one ( ) opens a dialog box to add a new 

shape to the tree (more details in section 5.4.1). The second one ( ) duplicates the 

selected shape(s) and the third one ( ) deletes all the shapes currently selected in 

the tree. The last one ( ) is enabled when at least two shapes are selected and 

allows creating Boolean operation using selected shapes. 

• The two buttons on the right side allow performing actions on the currently selected 

shape(s). The first one ( ) opens a dialog box to apply a transformation to all the 

elements currently selected (see section 5.4). The second one ( ) offers the possi-

bility to use a clipping filter. This button triggers the apparition of a dialog box allowing 
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the user to set the parameters of the clipping filter, see Figure 11. This filter performs 

a cut in the geometry to view more precisely the inner geometry of the modelled sys-

tem. The clipping is set with the coordinates of a centre point and a normal direction. It 

will keep the geometric representation of the selected element in the half-space defined 

by this point and the normal. To get a more interactive setting, you can select the “Dis-

play 3D control widget” that will display an interactive control in the 3D view to change 

the clipping. These 3D controls of the filter are materialised by a sphere (representing 

the centre of the clipping operation) and an axis with two arrows (representing the nor-

mal direction), see Figure 11. 

    

Figure 11: Clipping filter applied on Raspberry Pi Zero housing with the 3D control 

widget enabled (left) and clipping control pane (right) 

5.1.2. Properties panel 

This panel shows the properties of the shape currently selected in the Shapes tree. It shows 

properties only if there is one — and only one — shape selected. Depending on the shape 

selected, the properties displayed change accordingly.  

The user can thus define the dimensions of the shape. For each shape, parameters vary and 

explanatory schemes are presented in section 5.2. These pictures are also available in the 

software by clicking on the “Help” button ( ). 

This panel shows also fields to choose the position and orientation of the object and the unit 

of measure. The unit for parameters, positions and rotations can be changed and an automatic 

conversion of values is proposed. The default units are millimetres (mm) for lengths and radi-

ans (rad) for angles. The orientation parameter represents the orientation of the shape around 

its centre of mass: each angle (also known as Euler angle) represents an orientation around 
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the X, Y and Z axis respectively. Those rotations are applied in the following order: first the Z 

orientation, then the Y one and finally the X rotation. 

 

i. Thickness parameter and Boolean operations 

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have an additional 

useful parameter (not present in GDML) called thickness. If a shape has a thickness defined (different 

from 0), then the export of this shape will be done using Boolean operations (a subtraction between the 

outer element and the inner element). It allows the user to gain time for this kind of operations.  

This kind of shape can be very useful during the definition of radiation analysis. The user shall be aware 

that this thickness value is not a GDML parameter, which means that setting this parameter to a value 

different from zero will result, in the GDML file, to the corresponding Boolean operation. The little warning 

sign ( ) next to the name of this parameter is present to remind the user of this. 

If an EDGE file containing a shape with a defined thickness (different from 0) has been saved and is 

then loaded again, the user must note that the concerned shape will be displayed as Boolean opera-

tions. It means that when the user will click on the corresponding shape, it will be displayed as a Boolean 

operation and the user will have to “deconstruct” the Boolean operation to edit its elements parameters. 

5.1.3. 3D View 

The 3D view is showing in real-time the product of the GDML model. It is possible to interact 

with the view using the mouse to control it: 

• Left click (hold) and movement: rotate the scene; 

• Wheel (hold) and movement: translate the scene; 

• Right click (hold) and movement: zoom; 

Or the keyboard: 

• “R” resets the view and shows all the shapes of the scene; 

• “I” to zoom in; 

• “O” to zoom out;   

• “W” displays the shapes as wireframes; 

• “S” displays the shapes as solid; 

• The up/down/left/right arrows rotate the scene.  
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The buttons at the top of the view also facilitate its handling: 

•  resets the view and shows all the shapes of the scene (“R” key shortcut); 

•  aligns the view along +X axis; 

•  aligns the view along -X axis; 

•  aligns the view along +Y axis; 

•  aligns the view along –Y axis; 

•  aligns the view along +Z axis; 

•  aligns the view along -Z axis. 

NB: Sometimes, at the launch of the software, the 3D view is not correctly initialised. To refresh it, 

change perspective to another one and come back to the initial perspective, the 3D view is now correctly 

initialised. It can also happen when using several screen and moving the application from one screen 

to another one. 

On top of the 3D view, a drop-down menu allows the user to choose a model operation to 

launch (cf. section 5.5). These operations are also available through the Tools menu presented 

in section 3.3.1.i. 

On the bottom of the 3D view, an information bar displays useful 

information about the current selection: the number of selected 

elements as well as the size and the position of the bounding 

box — the red box around selected elements. It is possible to 

click on the number of selected elements to display a list of the 

currently selected elements as shown on Figure 12. 

5.2. Available geometric shapes 

EDGE handles several primitive geometric shapes as shown on Figure 13. Other kind of 

shapes are also supported and presented in section 5.3. 

 

Figure 13: Available shapes 

 

The figures from Figure 14 to Figure 25 on the following pages present the parameters of all 

the shapes handled by EDGE. For concerned elements, the parameter thickness is explained.  

Figure 12: List of se-

lected elements 
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Figure 14: Box parameters 

 

Figure 15: Cone parameters 

 

 

Figure 16: Ellipsoid parameters 

 

Figure 17: Elliptical cone parameters 
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Figure 18: Elliptical tube parameters 

 

Figure 19: General trapezoid parameters 

 

 

 

Figure 20: Orb parameters 

 

Figure 21: Paraboloid parameters 

 



 EDGE 2.5.0 

User Manual 
PAGE 

24/49 

 

Status: final Date: 30/10/2020  

 

 

Figure 22: Parallelepiped parameters 

 

Figure 23: Sphere parameters 

 

Figure 24: Trapezoid parameters 

 

Figure 25: Tube parameters 
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5.3. Other shapes available  

5.3.1. Tessellated Solid 

Solids with complex geometries can be constructed by importing tessellated surfaces, includ-

ing initially B-Rep based models. Numerous formats are supported (.geo, mesh file, STEP AP 

203 – 214 ...). Those tessellated surfaces are converted into an equivalent GDML tessellated 

solid object. 

Please notice that the imported tessellated surface must imperatively be a close surface. 

EDGE displays a warning message to the user if it is not the case.  

 

Figure 26: Example of an imported tessellated solid 

5.3.2. Assemblies 

In EDGE, the user has the possibility to handle “assembly” elements. Those elements are 

grouping several shapes without being attached to a geometric shape. 
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5.3.3. GDML file 

EDGE also allows importing all the geometry concepts from another GDML file and including 

them as a child of the currently selected element. This option can be very useful if users want 

to check the position of a specific subsystem (defined in the imported GDML file) in the whole 

system (main GDML file). An example is shown on Figure 27. 

 

Figure 27: Example of import of GDML file 

5.4. Edition of the geometry 

5.4.1. Creating/adding a new shape 

The user has first to create a “world” shape that will include all subsequent shapes. The posi-

tion (0, 0, 0) corresponds to the barycentre of this world shape. Once this is done, it is possible 

to start the construction of the desired object. 

NB: Even if technically GDML allows creating a world smaller than the final object, it is not recom-

mended. The world shape typically corresponds to the computational domain of numerous of simulation 

software using GDML files in input. And most of these tools will not work properly nor give relevant 

results if the world shape does not encapsulate all other elements. The relevant definition of the world 

shape remains on the responsibility of the user and with respect to the final targeted application.  
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Clicking on the “ ” button (or the Add the world shape /“ ” link if the corre-

sponding option in the Preferences is enabled, see section 4), calls the New Shape Wizard 

(Figure 28). On the left panel of the dialog box, all the available shapes are represented. A 

click on a shape selects it and shows its properties on the right panel. Properties requirement 

varies with the different shapes, but for each ones the Name, Unit Configuration, Position and 

Rotation can be informed. All the properties can be edited via the Properties Panel (Figure 9, 

box 2).  

 

Figure 28: New shape dialog box 

If the tree is empty, the first new shape will become the “world” shape. After that, each new 

shape will be added to the tree as a child of the current selected element. If no element is 

selected, the new element will be added as a child of the “world box”. This feature makes 

possible the creation of objects with a complex hierarchy of objects.  

The new shape dialog box displays all the available import options which may vary depending 

on the installed plug-ins. Basic ones are the B-Rep format files import (.geo, .msh, .stl, .unv), 

or the GDML file import. 
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5.4.2.  Transforming several elements 

Position and orientation can be directly edited in the properties panel. However, as it is not 

convenient to use this feature on each element to move, a multi-transformation tool has been 

implemented, accessible via the “Transform” icon of the Shapes tree panel (see section 5.1.1). 

Once the elements to modify in the tree are selected, click on the Transform button   ( ). 

The dialog box showed in Figure 29 then appears. 

 

Figure 29: Multi-element transformation dialog 

This dialog box allows setting the translation and rotation to apply to the elements. 

These transformations can replace the current position and orientation properties of the ob-

jects or be added to any existing placement information. For example, for an object at a (1, 1, 

1) position, a transformation of (2, 0, 0) with “Add” will displace the object to (3, 1, 1), when 

“Replace” will displace it to (2, 0, 0). 

5.4.3. Creating Boolean operation 

Using the create Boolean operation button ( ), it is possible to create Union, Intersection 

and Subtraction directly in EDGE. In order to create a Boolean operation, please select two 

elements and click on the button. The dialog shown below will appear and let you choose a 

name for the Boolean operation, which is element is the first and which one is the second and 

finally the type of operation.  

It is also possible to create directly a multi-union that groups more than two elements directly. 

NB: Please note that the order is important for subtraction and intersection only. 
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5.5. Model operations 

The user can perform operations on the created CAD model thanks to the drop-down menu 

“Model operations”. The list of available operations may be subject to changes depending on 

both the version and the license of EDGE used. Available operations by default are: 

5.5.1. GDML File validity check 

This operation checks the syntax validity of a GDML file against the GDML file format specifi-

cations. It is possible to check the current file (if saved beforehand) or any file from the system. 

The Figure 30 shows the tool appearance. 

 

 
Figure 30: GDML file validity check tool 

5.5.2. Check for overlaps 

This operation allows the user to check if there are no overlaps inside the geometry, meaning 

that there are no shapes overlapping each other. The user can choose if “touching” shapes 

should be considered as overlapping or not. To launch the calculation, the user can click on 

the “Play” button. The “Stop” button allows the user to stop the calculation at any time. The 

results of the operation are presented on Figure 31. 

 

Figure 31: Overlaps calculation results  

(indicates that the LeftPanelCenter and RightPanelCenter elements are overlapping) 
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5.5.3. Compute volume 

This operation allows the user to obtain the volume of the geometry. The computed value is 

an approximation of the real volume value based on 3D meshing of the shapes. As for the 

previous operation, the calculation is launch with the “Play” button and can be stopped with 

the “Stop” button (cf. Figure 32). 

 

Figure 32: Volume computation results 

5.5.4. Reorganise model 

This operation allows the user to check the consistency of the hierarchy of the model. Indeed, 

to get proper radiations results, elements that are included in other ones (geometrically) should 

be placed as child of the geometrical shapes they are in. This tool computes the real hierarchy, 

displays the results to the user and proposes to modify the model accordingly. NB: due to 

current limitation on this tool, it will remove all assemblies from the model. 

 

Figure 33: Exemple of hierarchy reorganisation results. 
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6. Material definition 

The aim of this perspective is to define materials that will be attributed later to a geometric 

shape. 

The Material definition perspective has no 3D view but is composed of three main panels, as 

shown on Figure 34: 

•  Materials list, the list of user-defined materials; 

•  Geant4 Materials, the list of available Geant4 default materials; 

•  Material editor, panel to edit the currently selected material.  

  
Figure 34: EDGE material definition view 

6.1. About GDML materials 

In GDML format, materials are defined by their isotopic and stoichiometry compositions. Ma-

terials can be defined by a single “atom”, a composition of elements or fractions of elements. 
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2 

3 

1 

2 
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These elements can be simple “atom” or represent an isotropic distribution. Figure 36 presents 

different examples of material defined using the GDML formalism. 

 

Figure 35: Material definition in GDML 

 

Figure 36: Examples of different ways of defining a material in GDML 

6.2. Materials list 

Creating a material is performed by clicking on the “add material button” ( ).  

Warning: If the user creates a new material which is not attributed to a geometrical shape in the Mate-

rials affectation perspective, this material will not be saved inside the generated .gdml file when the user 

saves the file to GDML in EDGE. In order to save materials which are not attributed inside the .gdml file, 

the user needs to activate the option “Write non-used user-defined materials”, see section 4.3. 

In order to edit a material, a click on an element in the list updates the material editor with the 

current material where it can be edited (see section 6.4). It is possible to duplicate a material 

by clicking on the “duplicate button” ( ). Those new materials are added at the end of the 

materials list and their names are incremented in order to not confuse them with the initial 

materials. Deleting a selected material is performed by clicking on the “delete button” ( ). 
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By clicking on the “import materials button” ( ), it is possible to import materials from another 

GDML file or from a GDML materials the EDGE XML file format. In the case of a GDML file, 

this mechanism will import all materials written inside the GDML file. We remind that in order 

to write all materials in a GDML file, even the ones, which are not assigned to a geometry 

shape, the user must enable the corresponding option in the Preferences (see section 4.3). 

Finally, clicking on the “export materials button” ( ) exports the materials into a GDML ma-

terial file (.xml). All the user-defined materials will be exported. 

6.3. Geant4 materials 

Available Geant4 materials for the material assignment (see section 7) are displayed in the 

Geant4 materials panel, as shown on Figure 34. 

6.4. Material editor 

The material editor is separated in two main parts: the first one on the top is the same for every 

material allows defining the name, the density and other properties of the material. Below, a 

section enables to define the composition of the material and changes depending on the type 

of chosen material. Figure 37 below shows the editor for a simple “atom” material. On the top, 

it is possible to fill in the material name, the density in g/cm3 and optional properties before 

choosing the type of material. 

  

Figure 37: Material editor for an "atom" material showing the optional properties 
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General optional properties can be set by clicking on the “Show optional properties” and are: 

• The choice of the atomic number Z; 

• The formula; 

• The state (liquid, solid, gaseous); 

• The absorption length (AL); 

• The mean excitation energy (MEE); 

• The pressure (P); 

• The radiation length (RL); 

• The temperature (T). 

The user can then choose a material type. As shows Figure 35, a material can be defined by 

three different ways.  

  

Figure 38: Material editor for a composition of element (here water) 

Figure 38 shows the material editor for a composition of elements. These elements are similar 

to atom shown previously but can have additional meta-data attached to them using the “Show 

optional properties” button. The number of each element is chosen on the left with the “n” field. 

It is easy to add and remove elements just by clicking on the ( ) button and ( ) respectively. 

It is possible to define material with isotopes instead of elements. In this case each element is 

made of fractions of isotopes. Also, it is possible to define a material with fractions of ele-

ments/isotopes instead of compositions. 

To apply the modifications, it is necessary to click on the “Apply modifications” button. 
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7. Materials assignment 

The aim of this perspective is to apply the materials defined in the material definition view to 

the geometry defined in the geometry edition view. Thus, this view only makes sense when at 

least one shape has been defined in the geometry perspective. 

The materials assignment perspective has the same 3D view as the geometry one (like shown 

on Figure 39):  

•  Materials list, list of the geometric shapes and their currently applied material; 

•  Material selection, panel to select the material for the currently selected shapes. 

   

Figure 39: EDGE material edition view 

 

7.1. Materials list 

This panel contains a tree-table with two columns. The first column (on the left) lists the geom-

etry shapes created in the Geometry edition perspective. The second column (on the right) 

lists the materials attributed to each corresponding geometry shape. By double-clicking on the 

right column, it is possible to change material assignment without going inside the editor.  

By default, the Geant4 material “G4_Galactic” (i.e. space environment) is attributed to the geometry 

shape representing the world. All other geometry shapes created are, by default, composed of “De-

fault_Material”. This behaviour can be changed in the Preferences, see section 4.2. 
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7.2. Material selection 

The Material selection panel allows the user to select the material to attribute to a geometry 

shape, defined in the Geometry edition perspective. 

When a geometry shape is selected in the Material list panel, the Material selection panel 

displays several choices for the user: 

• Pre-defined materials: some pre-defined materials exist (see section 6.3) and can be 

directly used to define the material for the selected shape. When this option is selected, 

a drop down list appears, displaying all default materials already available in EDGE 

(the embedded “Default_Material” and all Geant4 materials).  

• Custom materials: When this option is selected, a drop down list appears, displaying 

all the materials created in the Material definition perspective. 

When the chosen materials are selected in the drop down list, the modification must be saved 

by clicking on the “OK” button. 
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8. GDML File perspective 

EDGE provides a rich text-editor to complete the capabilities of the GUI and let the user freely 

edit and extend the generated GDML file and currently loaded in EDGE. The perspective is 

dedicated this editor and shown on Figure 40.  

   

Figure 40: EDGE GDML file view 

A rich text-editor shows how the GDML file would be generated on disk. The content of the 

editor is updated each time the perspective is opened. 

It is possible to modify the GDML file directly by editing the generated content. Once modifica-

tion performed, it is possible to reload the file into EDGE (to see the modifications in the 3D 

view for example) using the “Save&Update EDGE” button but it is also possible to save the 

produced content to the hard disk by using the “Save as…” button. 

This editor provides a syntactic colorization and completion, this last one available by typing 

ctrl+space key combination. 

Be aware, that when reloading your modification into EDGE, it will be reinterpreted by the 

software and if you switch back to the file, its content will be re-generated from EDGE data-

model and thus have a different syntax but will represent the same system. 

NB: please note that this perspective is disabled in TRIAL mode of EDGE and you need the full version 

of EDGE to use it. 
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9. Additional modules 

Important remark: Access to additional module operation is provided through additional plug-

ins and may require an additional license and/or depends on your EDGE license. Please, send 

an email to contact@space-suite.com or on our website https://www.space-suite.com/contact/ 

for more information. Please see section 3.3.1 at page 11 for further information regarding the 

installation procedure.  

9.1. SSAM – Sector Shielding Analysis Module 

SSAM is not provided with the default packing of the EDGE. 

SSAM is used to perform a sector shielding analysis on the CAD model in EDGE. Using a ray-

tracing technique, SSAM will perform, from a target point of view, an evaluation of the shielding 

thickness in all directions of a selected angular sector. The target can typically be a sensitive 

device on which the user wants to evaluate radiations effect. Taking into account the nature of 

attributed materials, the geometrical thickness is converted into aluminium effective one. For 

this reason, please note that the geometry must be properly defined and materials assigned 

to it in order to use SSAM.  

To launch SSAM, select SSAM in the model operation list.  

SSAM needs the following input parameters as illustrated in Error! Reference source not 

found.:  

• the position where to perform sector shielding analysis (x, y, z and length unit); 

• the number of sphere sectors around this point to divide the space in theta(θ) and phi(φ) 

directions – with theta varying between0 and 2π phi  varies 0 and π; 

• the total number of rays to launch for the sector shielding analysis. 

 

Figure 41: inputs parameters for SSAM 

Click on the  button to launch SSAM. From the defined position, the selected number of 

rays is launched in all directions (using an isotropic distribution). SSAM computes the distance 

https://www.space-suite.com/contact/
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in each material density type crossed by the ray and calculates the equivalent thickness of 

Aluminium defined by a density of 2.699 g/cm3. All these results are then summarised for each 

sphere sector computing the minimal, mean and maximal of the equivalent thickness of Alu-

minium. 

NB: Please note that SSAM also check if there is no overlap in the geometry to avoid problems during 

the calculations. If it detects overlaps, the computation will stop with a message explaining it.  

SSAM results are displayed after all the rays are launched. There are several areas to dis-
play SSAM results as illustrated in Error! Reference source not found.. 

 

Figure 42: SSAM results 

The panel labelled “1” presents a 3D view of the different results computed with SSAM. 

The panel labelled “2” lists these the elements and allow to change their visibility, transparency 

and colours by clicking on the corresponding checkboxes and coloured buttons. By default, 

the modelling geometry is displayed in transparency and in black colour. The position of the 

target is represented by a red sphere. Please note, in some cases, this sphere can be small 

compared to the global geometry size and a zooming might be needed to see it.  

In the panel labelled “3”, a table is displayed with 4 columns and several rows. Each row is the 

result of a sphere sector defined by a division in theta and phi directions described by the input 

parameters. The columns are respectively the mean, the minimum, the maximum and the 

standard deviation of the mean values of the equivalent thickness of aluminium in this sphere 

sector. All these values are expressed in metre. The standard deviation is computed with the 

following formula, with “nb of ray” the total ray launched in the sphere sector, “ti” the equivalent 

thickness of the ray i, “tmean” the mean of all equivalent thicknesses in the sphere sectors: 

𝑑𝑒𝑣𝑖𝑎𝑡𝑖𝑜𝑛 = √
∑ (𝑡𝑖 − 𝑡𝑚𝑒𝑎𝑛)2𝑛𝑏 𝑜𝑓 𝑟𝑎𝑦

𝑖=1

𝑛𝑏 𝑜𝑓 𝑟𝑎𝑦 − 1
 

2 
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The contextual menus bar labelled “4” provides several possibilities to displays the selected 

results in the 3D view or as plots, export them into CSV format files or to compute the dose 

received by the target. 

The “Show in 3D…” menu allow to display results in the 3D view. The selected result appears 

in the 3D view and is listed in the control panel “2” (cf. Error! Reference source not found.). 

The following 3D representations are available: 

• The minimum, mean or maximum of the equivalent aluminium thickness for each 

sphere sector. More information about each sphere sector can be obtained by clicking 

on each sphere sector item in the list of 3D items. An example of such representation, 

commonly called “hedgehog view”, is in Error! Reference source not found. (a); 

• The average sphere considering the mean of the equivalent aluminium thickness for 

all rays launched by SSAM. The details regarding this sphere, like the diameter can be 

displayed by clicking on the item in the list of 3D items. The information bar at the 

bottom of the 3D view gives the size of the selected element bounding box enabling to 

quickly access the size of the sphere; 

• The number of interceptions for each face of the geometry. This 3D result can be used 

to check if enough rays have been launched to provide a statistic good enough: if a 

face has zero interceptions, it indicates that not enough rays has been launched to 

intercept this face. When selecting this results in the list of 3D items, a scalar bar ap-

pears helping assess the value represented by each colour; 

• The minimum, mean or maximum hollow sphere sectors of equivalent aluminium thick-

ness. Users must set the inner radius of the hollow sphere, and the space between 

each sphere sector. The details of each hollow sphere sector are available by clicking 

on each sphere sector item in the list of 3D results. An example of this result is shown 

in Error! Reference source not found. (c). 

• A coloured sphere where each colour represents the value of the equivalent thickness 

of Aluminium in metre. When selecting this results in the list of 3D items, a scalar bar 

appears helping assess the value represented by each colour. An example of this result 

is shown in Error! Reference source not found. (d). 
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Figure 43: available 3D results: (a) 3D sphere sectors results or “hedgehog view” (b) 

number of intercepting rays for each face (c) 3D hollow sphere sectors results (d) 

sphere sector aluminium equivalent thickness mapped on a coloured sphere 

The “Plot…” menu enables to display plots of meaningful results into new pop-ups windows. 

The following results are available: 

• y = f(x) chart type where the minimum, the mean and the maximum of the equivalent 

thickness of Aluminium in metre for each sphere sector is displayed. An example is 

shown in Error! Reference source not found.; 

• y = f(x) chart type with the mean of the equivalent thickness of Aluminium in metre and 

its standard deviation are displayed for each sphere sector. An example is shown in 

Error! Reference source not found.; 

• A 2D Map showing the angular repartition of the equivalent thickness of Aluminium for 

each sphere sector. An example is shown in Error! Reference source not found.. 

 

a b 

c d 
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Figure 44: minimum, mean and maximum equivalent thickness of Aluminium in metre 

for each sphere sector. 

 

Figure 45: The mean of the equivalent thickness of Aluminium and its standard devia-

tion in metre for each sphere sector 

 

Figure 46: the angular repartition of the equivalent thickness of aluminium in metre for 

each sphere sector 
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The “Export…” menu enables to save the following results on the disk: 

• The equivalent thicknesses of Aluminium in metre to a CSV file; 

• An equivalent sphere with a radius equal to the average of the equivalent thicknesses 

of Aluminium of all rays used for SSAM. This sphere is exported to a GDML file; 

• The number of rays which intercepted each face of the geometry in a VTK file; 

• The hollow sphere sectors using the minimum, the mean or the maximum of the equiv-

alent thickness of Aluminium of all sphere sectors. The hollow sphere sectors are ex-

ported to a GDML file. Users must set the radius of the hollow sphere, and the space 

between each sphere sector to avoid cross contacts and overlapping between sectors 

to respect GEANT4 constraints. 

The “Dose computation” menu, opens a new popup, as illustrated in Error! Reference source 

not found., to compute the cumulative dose based on the previous computed aluminium 

equivalent thicknesses. Users must beforehand set the tabulated function defining the evolu-

tion of the cumulative dose versus the depth of a material, using external software, models or 

experimental data. The user may, for instance, use the Shildose2 model, as provided in the 

frame of the ESA/BIRA/Spenvis online application.  

It is possible to set it manually directly in the editor or to load a csv file with two columns 

separated by a comma. The first column defines the depth and the second one the dose. An 

example of such file is in the section 11 page 48 and also in the “data” directory of EDGE.  

Additionally, it is also necessary to set the unit of the two axes: Gray or Rad for the dose and  

g/cm2 or millimetre of a material with a specific density for the depth. If the selected unit is 

g/cm2, then it is not necessary to set the density because the results do not depend on the 

density of the material. Finally, on the right part of the editor, the points of the tabulated function 

are displayed. 

When the inputs parameters for the dose computation are set, users can click on the 

 button. Both the equivalent thickness of Aluminium of each sphere sector and 

the dose versus depth tabulated function are used to compute the deposited dose using the 

following formula, where Ωi is the surface of the sphere sector i, D(Ti) is the dose for the equiv-

alent thickness of Aluminium of the sphere sector i: 

𝑇𝑜𝑡𝑎𝑙𝐷𝑜𝑠𝑒 =
1

4𝜋
∑ 𝛺𝑖𝐷(𝑇𝑖)

𝑠𝑝ℎ𝑒𝑟𝑒𝑆𝑒𝑐𝑡𝑜𝑟𝑠

𝑖

 

Then a new popup appears with the results of the cumulative doseError! Reference source n

ot found.. The results are computed considering the minimum, the mean and the maximum 

of the equivalent thickness of Aluminium for all sphere sectors. Users can choose to save 

these results in a dedicated file by clicking on the  button. 
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Figure 47: Dose computation input parameters 

Important remark: Please pay attention the sector shielding analysis approach implies the 

particle transport through the matter be averaged as straight lines from the sources to the 

target, without scattering, diffusion, secondary particles emissions. This may constitute a se-

vere assumption is some cases, like for electrons diffusion. Moreover, the position of the punc-

tual target, as defined in SSAM, may deeply impact the effectively viewed shielding, i.e. effect 

of point-of-view, and the total cumulated dose of a larger sensitive component, with a spatial 

extension, be significantly differ. For these reasons, results computed with a sector shielding 

analysis should be considered with care and remain of the full responsibility of the end user 

and his expertise.  

Please contact us for further support by our experts and/or advanced studies (contact@space-

suite.com).  

9.2. DeCADe – Detesselator and Extended CAD importer 

DeCADE, for Detesselator and Extended CAD importer, is an EDGE-plug-in providing ex-

tended STEP-AP format capabilities and a set of geometry simplification and clean-up features 

to adapted the imported geometry to radiations analysis. 

Please note that currently, the STEP-AP importer part of the plugin is only available on Linux systems. 

mailto:contact@spacesuite.com
mailto:contact@spacesuite.com
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9.2.1. Smart STEP-AP importer:  

As any importer, the Smart STEP-AP importer is available in the File > Import menu or inside 

the “Add new shape” dialog. 

The extended STEP-AP importer allows you to: 

• Import STEP element by element (i.e. shell by shell) by 

selecting the “Separate elements” check-box 

• Sort elements by size when imported in EDGE to facili-

tate the removal of small elements by checking the “As-

cending sort by size” check-box. 

The screenshot below presents an example of imported STEP-

AP file (a Raspberry Pi card) inside EDGE using the DeCADe 

smart importer.  

 

Figure 49: Example of imported STEP-AP file in EDGE. 

9.2.2. Detessellation operation: 

After importing a STEP-AP, or any other meshed/b-rep based format, the geometry is made 

of tessellated elements that cannot be edited and are induce more CPU cost when performing 

Geant4 analysis. 

A new function called “Detessellator” enables to convert tessellated elements into CSG primi-

vites fully compatible with GDML. To use this function, after selecting the elements who want 

Figure 48: STEP-AP import 

dialog preview 



 EDGE 2.5.0 

User Manual 
PAGE 

46/49 

 

Status: final Date: 30/10/2020  

 

to detessellate, click on the detessellate icon ( ) in the toolbar on top of the list of shapes. A 

new dialog appears to select a few options:  

• Separate non-continuous shapes: when selected, this function will detect in the tes-

sellated element if there are non-continuous surfaces that represents two different 

shapes. Then it will create a shape per different continuous surface. If not selected, the 

tessellated element is considered as only one element. It is recommended to keep this 

option active. 

• Automatic shape detection: when selected, the algorithm detects automatically 

which primitive is closer to the selected element between Boxes, Cones and Spheres. 

If not selected, you must choose by which primitive the tessellated shape will be ap-

proximated. The available shapes are then Box, Cone, Cylinder, Ellipsoid and Sphere. 

The Figure 50 Error! Reference source not found. presents an example of detessellation, 

here on an embedded computer mother board from an initial STEP-AP file in a cubesat. The 

left view shows the initial import as triangulated surfaces. The right side view shows the equiv-

alent pure CSG / GDML model. All components have been automatically detected and con-

verted by the detesselator. 

 

Figure 50: Example of detessellation: tessellated elements (left) versus GDML primi-

tives obtained with DeCADe (right). 

In most of the usual cases, canonical shapes can be automatically detected, sized and located 

or, for the most complex case, can manually be pre-identified by the user through the GUI and 

automatically sized, located and oriented automatically by the application. 
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10. Annex A: Example of materials description 

Here after is presented an example of material definition in GDML format (partial description).  

<materials> 

     <!--   Examples of basic or fundamental materials --> 

 <element name="videRef" formula="VACUUM" Z="1"> 

  <atom value="1"/> 

 </element> 

 

 <element name="aluminum" formula="Al" Z="13"> 

  <atom value="26.9815"/> 

 </element> 

 

 <element name="carbon" formula="C" Z="6"> 

  <atom value="12.0107"/> 

 </element> 

 

 <element name="Hydrogen" formula="H2" Z="1"> 

  <atom value="1.01"/> 

 </element> 

 

 <element name="Nitrogen" formula="N2" Z="7"> 

  <atom value="14.01"/> 

 </element> 

 

 <element name="Oxygen" formula="O2" Z="8"> 

  <atom value="16.0"/> 

 </element> 

 

     <!--   Examples of complex or composite materials --> 

 <material name="Mat_ALUMINUM" formula="ALUMINUM"> 

  <D value ="2.7000" unit="g/cm3"/> 

  <fraction n="1.0000" ref="aluminum"/> 

 </material> 

 

 <material name="Mat_Kapton" formula="Kapton"> 

  <D value ="1.42" unit="g/cm3"/> 

  <fraction n="0.0273" ref="Hydrogen"/> 

  <fraction n="0.7213" ref="carbon"/> 

  <fraction n="0.0765" ref="Nitrogen"/> 

  <fraction n="0.1749" ref="Oxygen"/> 

 </material> 

</materials> 
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11. Annex B – Example of csv file for the dose compu-

tation 

Here after is presented an example of csv file defining the dose in Rad versus the depth in 

g/cm2 in a tabulated function for the dose computation. The first column is the depth and the 

second column is the dose 

0.01, 1800000 

0.03, 1100000 

0.05, 500000 

0.08, 250000 

0.10, 130000 

0.13, 79000 

0.16, 52000 

0.21, 28000 

0.27, 19000 

0.40, 10000 

0.50, 6000 

0.70, 4200 

0.80, 3100 

1.1, 1900 

1.3, 1300 

1.6, 1100 

1.9, 1000 

2.1, 900 

2.4, 800 

2.7, 750 

3.2, 700 

3.8, 650 

4.3, 600 

4.9, 570 

5.4, 500 
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